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About this guide
This guide tells you how to

� install Sophos Anti-Virus on a Windows 2000 server

� install Sophos Anti-Virus on Windows NT/2000/XP workstations

� install Sophos Anti-Virus on Windows 95/98/Me workstations.

The instructions for installation on Windows XP workstations do not apply to
Windows XP Home networked computers.

More information
This guide describes a recommended form of installation.

� You can find details of all other installation and configuration options in
the Sophos Anti-Virus Windows NT/2000/XP user manual.

� To find out how to update Sophos Anti-Virus on the Windows 2000
server, see the Sophos Anti-Virus Windows NT/2000 server update
guide.

� Most Sophos documentation is published on the Sophos CD each month.

Technical support
UK (24 hours): (+44) 1235 559933 support@sophos.com

USA: (+1) 888 767 4679 supportus@sophos.com

Australia (24 hours): (+61) 2 9409 9111 support@sophos.com.au

France: (+33) 1 41 99 94 20 support@sophos.fr

Germany: (+49) 6136 91193 support@sophos.de

Japan (24 hours): (+81) 45 348 8400 support@sophos.co.jp

Singapore: (+65) 6776 7467 supportasia@sophos.com
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Before you begin

You must uninstall any other anti-virus software before installing Sophos
Anti-Virus.

Before you begin, decide on which server you will install the central copy of
the Sophos Anti-Virus files.

Write the name of the server and the domain in Appendix 2. This
information will be useful when you update Sophos Anti-Virus.

Find out the name of the server and domain as follows:

1. At the Windows 2000 server, right-click the My Computer icon on the
desktop to display a menu. Select Properties.

2. In the System Properties dialog box, click the Network Identification tab.

The server name (Computer full name) and the Domain are displayed in the
System Properties dialog box. In this example, the server is called 1D and
the domain is called xmas.

3. If you haven’t already, write  the server name and domain in Appendix 2.
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Installation on the Windows 2000 server
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1 Creating the central installation directory

The central installation directory is the central copy of Sophos Anti-Virus
files from which Sophos Anti-Virus is installed on the server and
workstations. Whenever you update the central installation directory, Sophos
Anti-Virus is updated on the workstations without affecting users.

Create the central installation directory as follows:

1. At the Windows 2000 server, log on with Administrator rights.

If you have already downloaded and unzipped the Sophos Anti-Virus for
Windows NT/2000/XP files from the Sophos website, go to step 4.

2. Insert the Sophos CD in the CD drive. The CD should auto-run. If auto-run is
disabled, run D:\Launchcd (where D: is the CD drive).

3. In the Sophos CD window, click Sophos Anti-Virus. At the next screen, click
Windows NT/2000/XP, and start the setup program.
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4. In the SOPHOS Setup dialog box, click Next to continue the installation.

5. In the SOPHOS Setup - Installation Type dialog box, click Central
installation/upgrade. Click Next.
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6. In the SOPHOS Setup - Folder Selection dialog box, click Next to accept
the default folders.

7. In the SOPHOS Setup - Installation Options dialog box, ensure
Auto-upgrade is selected. Click Next.
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8. In the SOPHOS Setup - Auto-upgrade mode dialog box, click
Non-interactive. Deselect Allow users to postpone auto-upgrade and set
the Auto-upgrade check frequency to 60 minutes. Click Next.

9. In the SOPHOS Setup - Configuration Details dialog box, click Finish to
copy the files to the central installation directory.
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10. In the SOPHOS Setup Complete message box, click OK.

Now download the latest virus identity files (IDEs) from the Sophos website
(section 2).
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2 Downloading the latest virus identity files (IDEs)

This section describes how to download IDEs from the Sophos website.

A virus identity file (IDE) is a file that enables Sophos Anti-Virus to detect a
specific virus. You need IDEs to protect your network against viruses
discovered since your version of Sophos Anti-Virus was compiled.

Download IDEs as follows:

1. At the server, go to the IDE download page of the Sophos website
(www.sophos.com/downloads/ide).

If you use Internet Explorer 5.0, click the Virus identities (IDE) files FAQ
link and read the note on IE 5.0.

2. Click Download Zip and save the zipped file to the hard disk.

http://www.sophos.com/downloads/ide
http://www.sophos.com/support/faqs/ide.html
http://www.sophos.com/support/faqs/ide.html#2.3
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3. Unzip the file to

C:\Program Files\Sophos SWEEP for NT\NTInst\i386

If you do not have an unzip utility, scroll down the page and download the
IDEs one by one, to the location above.

Now create the auto-update account (section 3).
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3 Creating the auto-update account

The auto-update account is the account workstations use to log on to the
server and collect Sophos Anti-Virus updates from the central installation
directory.

Create the auto-update account on the Primary Domain Controller (i.e. the
computer you use to add new users to the domain) as follows:

1. At the taskbar, click Start|Settings|Control Panel.

2. In the Control Panel window, double-click Administrative Tools.
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3. In the Administrative Tools window, double-click Active Directory Users
and Computers.

4. In the Active Directory Users and Computers window, right-click the Users
folder to display a menu. Select New, then User.
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5. In the New Object - User dialog box, type ‘SweepUpdateAccount’ in the Full
name text box, and type ‘SWEEPUPD’ in the User logon name text box.
Click Next.

6. In the next New Object - User dialog box, type a password in the Password
and Confirm password text boxes. Deselect User must change password at
next logon, and select User cannot change password and Password never
expires. Click Next.
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7. In the final New Object - User dialog box, click Finish.

8. In the Active Directory Users and Computers window, you can now see
SweepUpdateAccount in the Users list. Close the window.
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9. In the Administrative Tools window, double-click Local Security Policy.

10. In the Local Security Settings window, in the Tree pane, click the plus sign
next to Local Policies, then click User Rights Assignment. In the Policy list,
double-click Log on as a service.
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11. In the Local Security Policy Setting dialog box, click Add.

12. In the Select Users or Groups dialog box, in the Name list, click
SweepUpdateAccount. Click Add.
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13. In the Local Security Policy Setting dialog box, click OK.

14. Close all windows.

You have created the auto-update account. Now install Sophos Anti-Virus
from the central installation directory onto the Windows 2000 server
(section 4).
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4 Installing Sophos Anti-Virus on the server

Install Sophos Anti-Virus on the Windows 2000 server as follows:

1. At the Windows 2000 server, log on with Administrator rights.

2. At the taskbar, click Start|Run.

3. In the Run dialog box, click Browse. Locate and double-click Setup.exe in

C:\Program Files\Sophos Sweep for NT\NTInst\i386

4. In the Run dialog box, click OK.

5. In the SOPHOS Setup dialog box, click Next to continue the installation.
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6. In the SOPHOS Setup - Folder Selection dialog box, click Next to accept
the default folders.

7. In the SOPHOS Setup - InterCheck Support and Network Access dialog
box, deselect Enable InterCheck Client and select Enable InterCheck
Server. Click Next.
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8. In the SOPHOS Setup - Installation Options dialog box, ensure
Auto-upgrade is selected. Click Next.

9. In the SOPHOS Setup - Auto-upgrade account details dialog box, type your
domain name, your account name (‘SWEEPUPD’), and the password you
entered when you created the auto-update account. Click Next.
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10. In the SOPHOS Setup - Auto-upgrade mode dialog box, click
Non-interactive. Deselect Allow users to postpone auto-upgrade and set
the Auto-upgrade check frequency to 60 minutes. Click Next.

11. In the SOPHOS Setup - Configuration Details dialog box, click Finish to
complete the installation.
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12. In the SOPHOS Setup message box, click Run SWEEP if you wish to view
the Sophos Anti-Virus window (see section 5), or click Exit.

Creation of the central installation directory and installation of Sophos
Anti-Virus on the server is now complete.

The central installation directory has been shared automatically as InterChk.
The path to the shared folder is

\\[servername]\InterChk

where [servername] is the name of the server on which you installed the
central installation directory.

Now carry out installations on the workstations.

� Installation of Sophos Anti-Virus on Windows NT/2000/XP workstations is
described in section 6.

� Installation of Sophos Anti-Virus on Windows 95/98/Me workstations is
described in section 8.
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5 Using Sophos Anti-Virus

The Sophos Anti-Virus window enables you to carry out and schedule
immediate scans.

To open the Sophos Anti-Virus window (on any computer on which Sophos
Anti-Virus is installed), at the taskbar click Start|Programs|
Sophos Anti-Virus|Sophos Anti-Virus.

The Immediate tabbed page enables you to carry out a virus scan on the
computer. Click the GO button to start the scan, and the STOP button to
stop it.

Drive names that have an illuminated light (i.e. Local hard drives in the
screenshot above) are scanned. Click the light to toggle it on and off.



Sophos Anti-Virus installation guide

26

Click the Scheduled tab.

By default a virus scan is scheduled for 21.00 every day. If the computer is
switched on, Sophos Anti-Virus will scan it for viruses at that time. Use the
Add, Remove and Edit buttons to change the times at which a scan takes
place.

To find out more about the Sophos Anti-Virus window, see the
Sophos Anti-Virus Windows NT/2000/XP user manual.



Installation on Windows NT/2000/XP workstations
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6 Installing Sophos Anti-Virus on Windows NT/2000/XP

This section describes how to install Sophos Anti-Virus on the Windows
NT/2000/XP workstations on the network. There are two alternative
methods:

� Install Sophos Anti-Virus on each workstation one at a time, by repeating
the procedure described in section 6.1.

or

� Carry out the procedure described in section 6.1 on one workstation,
then copy the installation to the other Windows NT/2000/XP workstations
using a network administration tool called SAVAdmin, as described in
section 6.2.

The second method is more complicated, but saves time on larger networks.

6.1 Install Sophos Anti-Virus on one workstation

To install Sophos Anti-Virus on one workstation, do the following:

1. At a Windows NT/2000/XP workstation, log on with Administrator rights.

2. At the taskbar, click Start|Run.

3. In the Run dialog box, click Browse. Locate and double-click Setup.exe in

\\[servername]\InterChk\NTInst\i386

where [servername] is the name of the server on which you installed the
central installation directory.

4. In the Run dialog box, click OK.
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5. In the SOPHOS Setup dialog box, click Next to continue the installation.

6. In the SOPHOS Setup - Folder Selection dialog box, click Next to accept
the default folders.
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7. In the SOPHOS Setup - InterCheck Support and Network Access dialog
box, select Enable InterCheck Client. Ensure that Enable InterCheck Server
and Enable scheduled sweeping of network resources are deselected. Click
Next.

8. In the SOPHOS Setup - Installation Options dialog box, ensure
Auto-upgrade and Prevent removal are selected. Click Next.
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9. In the SOPHOS Setup - Auto-upgrade account details dialog box, type your
domain name, your account name (‘SWEEPUPD’), and the password you
entered when you created the auto-update account. Click Next.

10. In the SOPHOS Setup - Auto-upgrade mode dialog box, click
Non-interactive. Deselect Allow users to postpone auto-upgrade and set
the Auto-upgrade check frequency to 60 minutes. Click Next.
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11. In the SOPHOS Setup - Configuration Details dialog box, click Finish to
complete the installation.

12. In the SOPHOS Setup message box, click Run SWEEP if you wish to view
the Sophos Anti-Virus window, or click Exit.

Now either repeat this procedure on each of the remaining Windows
NT/2000/XP workstations in the network, or go to section 6.2 to install
Sophos Anti-Virus on them all automatically.
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6.2 Install Sophos Anti-Virus on the remaining workstations

This section describes how to copy the installation you made in section 6.1
onto the other Windows NT/2000/XP workstations in the network.

As this procedure involves the installation of a network administration tool
(SAVAdmin), Sophos recommends that you perform it on a
Windows NT/2000 workstation you would normally use to manage the
network.

1. At the workstation, insert the Sophos CD.

2. In the Sophos CD window, click Sophos Anti-Virus.

3. At the next screen, click SAVAdmin.

4. At the next screen, start the SAVAdmin setup program.

5. In the Winzip Self-Extractor message box, click OK.

6. In the SAVAdmin for Windows NT/2000 Self-Extractor dialog box, click
Unzip.
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7. In the WinZip Self-Extractor message box, click OK to display the
SAVAdmin window.

8. In the SAVAdmin window, in the left-hand pane, locate your domain and
click it. The computers in the domain are shown in the right-hand pane. The
server and the workstation on which you installed Sophos Anti-Virus in
section 6.1 show Installed in the SAV Installed column.

9. Right-click the name of the workstation on which you installed Sophos Anti-
Virus in section 6.1 to display a menu. Select Copy SAV Config.

10. In the SAVAdmin message box, click Yes to save the configuration.
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11. In the Current Copy/Paste SAV Config dialog box, ensure your domain name
and SWEEPUPD are displayed in the Auto-upgrade account panel (bottom
right-hand corner of the dialog box). Click OK.

12. In the SAVAdmin window, hold down the ‘Ctrl’ key and click the names of
all the Windows NT/2000/XP workstations on which you would like to
install Sophos Anti-Virus.

13. Right-click one of the selected workstations to display a menu. Select Paste
SAV Config.
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14. In the Task Settings: Install SAV dialog box, click the Account details tab.
Click Current login domain. Check that the Domain name is correct. Type
‘SWEEPUPD’ in the User name text box, and type and confirm the
password.

15. Click the CID list tab and ensure the correct path to the central installation
directory is shown (see Appendix 2 if you are not sure of the path). Click
Apply, then click Create.

16. In the SAVAdmin message box, click Yes to start the installation.

In the SAVAdmin window you can see the workstations updating.

Users see the files being copied onto the workstations.

When installation is complete, SAVAdmin shows that the workstations have
Sophos Anti-Virus installed. They are protected by InterCheck, which means
all files are checked for viruses as they are accessed by the workstations.

You can use SAVAdmin to monitor workstation installations of Sophos
Anti-Virus at any time. Savadmin.exe is located at

C:\Program Files\Sophos\SAVAdmin\Ver2.20

For more information about SAVAdmin, see the SAVAdmin installation guide
or the SAVAdmin user manual.

Now test Sophos Anti-Virus (section 7).
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7 Testing Sophos Anti-Virus

1. At one of the Windows NT/2000 workstations on which you installed
Sophos Anti-Virus in section 6, insert the Sophos CD.

2. Right-click the Start button to display a menu. Select Explore to open
Windows Explorer.

3. Browse to the Tools\Utils folder and double-click SavTst32.exe.

4. In the SavTest32 window, on the File menu, click On-Access Test.

SavTest32 creates a file that simulates a virus. Sophos Anti-Virus reports a
virus find to the workstation and the server, and confirms that on-access
detection/prevention is working.

On-access detection/prevention is also known as InterCheck.

If SavTest32 reports that on-access detection/prevention is not functioning
correctly, contact Sophos technical support.

When you exit from SavTest32, the test file is deleted.

If you would like to test Sophos Anti-Virus on a Windows XP workstation,
you should first read the SavTest32 section of the utilities readme, located at

Tools\Utils\Readutil.txt

mailto:support@sophos.com
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Installation on Windows 95/98/Me workstations
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8 Installing Sophos Anti-Virus on Windows 95/98/Me

This section describes how to install Sophos Anti-Virus on the
Windows 95/98/Me workstations on the network. In this section SAVAdmin
is not used to install Sophos Anti-Virus on Windows 95/98/Me workstations.
Instead, a simpler method using the login script is described.

There are three steps:

� Create a central installation directory (CID) for Windows 95/98/Me on the
Windows 2000 server (section 8.1).

� Install Sophos Anti-Virus on the Windows 95/98/Me workstations (section
8.2).

� Enable SAVAdmin to monitor Windows 95/98/Me workstations (section
8.3).

8.1 Create the CID for Windows 95/98/Me

Creating the central installation directory for Windows 95/98/Me involves
two steps:

� Create the CID (section 8.1.1).

� Add the latest virus identity files (IDEs) to it (section 8.1.2).
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8.1.1 Create the CID

1. Log on to a Windows 95/98/Me workstation with Administrator rights to the
Windows 2000 server.

If you have already downloaded and unzipped the Sophos Anti-Virus for
Windows 95/98/Me files from the Sophos website, go to step 4.

2. Insert the Sophos CD in the CD drive. The CD should auto-run. If auto-run is
disabled, run D:\Launchcd (where D: is the CD drive).

3. In the Sophos CD window, click Sophos Anti-Virus. At the next screen, click
Windows 95/98/Me, and start the setup program.

4. In the SOPHOS Setup dialog box, click Next to continue the installation.
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5. In the SOPHOS Setup - Installation Type dialog box, click Central
installation/upgrade. Ensure InterCheck for Windows 95/98 and
InterCheck Monitor are selected. Click Next.

6. In the SOPHOS Setup - Folder Selection dialog box, click the lower Browse
button. Browse to the InterChk share on the Windows 2000 server and click
it. Click OK to return to the SOPHOS Setup - Folder Selection dialog box.
Type ‘\W95Inst’ at the end of the path under Sophos Anti-Virus destination
folder. Then click Next.
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7. If you are prompted to create the destination folder, click Yes.

8. In the SOPHOS Setup - Central Installation Options dialog box, select
Auto-upgrade and Prevent Removal. Click Next.

9. In the SOPHOS Setup - Auto-upgrade mode dialog box, click
Non-interactive. Click Next.
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10.In the SOPHOS Setup - Configuration Details dialog box, click Finish to
complete the installation.

11.In the SOPHOS Setup Complete dialog box, click OK.

You have created the central installation directory. Now add the latest IDEs
to it (section 8.1.2).
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8.1.2 Add the latest IDEs to the CID

1. Using Windows Explorer, find the folder

\\[servername]\InterChk\NTInst\i386

where [servername] is the name of your server.

2. The folder contains IDEs. Copy all files with the extension .ide to the folder

\\[servername]\InterChk\W95Inst

Now install Sophos Anti-Virus on the Windows 95/98/Me workstations
(section 8.2).
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8.2 Install Sophos Anti-Virus on the Windows 95/98/Me workstations

You can use one of two different methods to install Sophos Anti-Virus on the
Windows 95/98/Me workstations:

� Use the login script to install Sophos Anti-Virus on all Windows 95/98/Me
workstations simultaneously, as described in section 8.2.1.

or

� Install Sophos Anti-Virus on each workstation one at a time, by repeating
the procedure described in section 8.2.2.

8.2.1 To install Sophos Anti-Virus using the login script

If you do not already have a login script, go to Appendix 1 to find out how to
create one.

If you already have a login script, add the following text to it:

\\[servername]\InterChk\W95Inst\setup.exe -inl -a

start /wait \\[servername]\InterChk\Savagent.exe -update -poll=3600

where [servername] is the name of the Windows 2000 server on which you
created the central installation directory.

The next time users log in, installation will take place and they will see
InterCheck scanning their workstations.

If you have installed the SAVAdmin administration tool and want to use it to
monitor the Windows 95/98/Me workstations, go to section 8.3.

If you have not installed SAVAdmin, go to section 9 to test Sophos
Anti-Virus.
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8.2.2 To install Sophos Anti-Virus on an individual workstation

To install Sophos Anti-Virus on an individual workstation do the following:

1. Log on to the workstation with Administrator rights to the Windows 2000
server.

2. At the taskbar, click Start|Run.

3. In the Run dialog box, click Browse. Locate and double-click Setup.exe in

\\[servername]\InterChk\W95Inst

where [servername] is the name of the Windows 2000 server on which you
created the central installation directory.

4. In the Run dialog box, type ‘-inl -a’ at the end of the path. Click OK.

The Sophos Anti-Virus files are copied onto the workstation. When they have
been copied, Sophos Anti-Virus warns you that the workstation will restart.

When the workstation restarts, InterCheck scans the workstation.

5. Repeat this procedure at each workstation on which you would like to install
Sophos Anti-Virus.

If you have installed the SAVAdmin administration tool and want to use it to
monitor the Windows 95/98/Me workstations, go to section 8.3.

If you have not installed SAVAdmin, go to section 9 to test Sophos
Anti-Virus.
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8.3 Enable SAVAdmin to monitor Windows 95/98/Me workstations

If you chose not to install SAVAdmin during installation on Windows
NT/2000/XP workstations, go straight to section 9 to test Sophos Anti-Virus.

You enable SAVAdmin to monitor Windows 95/98/Me workstations by making
the SAVAgent utility available for distribution by your login script (see
section 8.2.1), as follows:

1. At the workstation on which you installed SAVAdmin, right-click the Start
button to display a menu and select Explore.

2. In Windows Explorer, locate

C:\Program Files\Sophos\SAVAdmin\Ver 2.20

and click it. Single-click Savagent.

3. On the Edit menu, click Copy.
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4. In Network Neighborhood (Windows NT) or My Network Places (Windows
2000/XP), locate

\\[servername]\InterChk

where [servername] is the name of the Windows 2000 server on which you
created the CID.

Open the InterChk shared folder.

5. On the Edit menu, click Paste.

The file is copied to the InterChk shared folder.

The next time users log in, the login script will place the SAVAgent utility on
the Windows 95/98/Me workstations, enabling SAVAdmin to monitor them.

For more information about SAVAdmin, see the SAVAdmin installation guide
or the SAVAdmin user manual.

Now test Sophos Anti-Virus (section 9).



Sophos Anti-Virus installation guide

50

9 Testing Sophos Anti-Virus

1. At one of the Windows 95/98/Me workstations on which you installed
Sophos Anti-Virus in section 8, insert the Sophos CD.

2. Right-click the Start button to display a menu. Select Explore to open
Windows Explorer.

3. Browse to the Tools\Utils folder and double-click SavTst32.exe.

4. In the SavTest32 window, on the File menu, click On-Access Test.

SavTest32 creates a file that simulates a virus. Sophos Anti-Virus reports a
virus find to the workstation and the server, and confirms that on-access
detection/prevention is working.

On-access detection/prevention is also known as InterCheck.

If SavTest32 reports that on-access detection/prevention is not functioning
correctly, contact Sophos technical support.

When you exit from SavTest32, the test file is deleted.

mailto:support@sophos.com
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Appendix 1 Creating a login script

Follow the instructions in this section if you intend to use the login script to
install Sophos Anti-Virus on your Windows 95/98/Me workstations, but you
do not yet have a login script.

There are two steps.

� Create the login script (Appendix 1.1).

� Assign the login script (Appendix 1.2).

Appendix 1.1 Create the login script

Create the login script as follows:

1. At the Primary Domain Controller (i.e. the computer you use to add new
users to the domain) use Windows Explorer (or My Computer) to locate

C:\Winnt\SYSvol\sysvol\[domain].com\scripts

2. On the File menu, select New and click Text Document.

3. Open the new text document and type the following text:

\\[servername]\InterChk\W95Inst\setup.exe -inl -a

start /wait \\[servername]\InterChk\Savagent.exe -update -poll=3600

where [servername] is the name of the Windows 2000 server on which you
created the central installation directory.

4. In the File menu, click Save As. In the Save As dialog box, change Save as
type to All Files and save the file with the name login.bat.

5. Close Notepad and Windows Explorer (or My Computer).
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Appendix 1.2 Assign the login script

1. At the taskbar, click Start|Settings|Control Panel.

2. In the Control Panel window, double-click Administrative Tools.

3. In the Administrative Tools window, double-click Active Directory Users
and Computers.

4. In the Active Directory Users and Computers window, click the Users folder
in the Tree pane.

5. In the Name list, right-click the name of a user that needs to have Sophos
Anti-Virus installed. In the menu that is displayed, select Properties.
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6. In the [user] Properties dialog box (where [user] is the name of the user you
right-clicked), click the Profile tabbed page. In the Logon script text box,
type ‘login.bat’.

The next time the user logs in, installation will take place. InterCheck will
scan the workstation.

Now repeat this procedure for each user to whom you want to assign the
login script.

If you have installed SAVAdmin and want to use it to monitor Windows
95/98/Me workstations, go to section 8.3.

Otherwise, go to section 9 to test Sophos Anti-Virus.
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Appendix 2 About the installation

This section lists the folders and accounts used in the Sophos Anti-Virus
installation. You will need this information when adding workstations to the
network or when updating Sophos Anti-Virus. Blanks are left for your own
information.

� Name of Windows 2000 server used for installation (p3):

...................................................................................................

� Domain to which the Windows 2000 server belongs (p3):

...................................................................................................

� Central installation directory for Sophos Anti-Virus for
Windows NT/2000/XP installation files as seen from the server:

C:\Program Files\Sophos SWEEP for NT\NTInst\i386

� Update account username (p15):

SWEEPUPD

� Update account password (p15):

...................................................................................................

If you write your password here, store this Installation Guide securely.

� Central installation directory for the Sophos Anti-Virus for
Windows NT/2000/XP installation files as seen from workstations:

\\[servername]\InterChk\NTInst\i386

� Central installation directory for the Sophos Anti-Virus for
Windows 95/98/Me installation files as seen from workstations:

\\[servername]\InterChk\w95inst
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